
The NVivo 2 tutorials 
The following tutorials accompany each chapter of Handling Qualitative Data with 
exercises in the previous version of QSR NVivo, revision 2. This version was replaced 
by NVivo 7 in February 2006. 

If you are working in NVivo 2, and at any stage wish to upgrade to NVivo 7, you can 
import the project you have created in these tutorials. 

Chapter summaries and software tutorials  
 Chapter 1 Setting Up

 Chapter 2 Qualitative Data

 Chapter 3 Data Records

 Chapter 4 Up from the Data

 Chapter 5 Coding

 Chapter 6 Handling Ideas

 Chapter 7 What are you aiming for?

 Chapter 8 Searching the data

 Chapter 9 Seeing a whole

 Chapter 10 Telling it

 

Tutorial for NVivo 2 Chapter 1: Setting Up 
This chapter was about starting out, and this tutorial is about starting out in software. 
logging the plans and the journey, entering the field, declaring the assumptions you 
bring with you, and learning the software tools you will use on the way. 

The exercises specify two different tasks. 

1. Meeting the software via an NVivo tutorial 
At this stage you need an overall familiarity with the tools offered by your software.  

If you have access to an introductory class or workshop, this gives the easiest first 
encounter with the software. Watching someone who knows it will quickly show you 
how to use it. 

If you are teaching yourself, use the tutorials provided with the software. To access the 
tutorials: 

1. Load NVivo from the CD provided. 

2. Start the NVivo application by clicking the desktop icon (or via 
Start/Programs/QSR/NVivo). 

3. On the NVivo launch pad click Open a Tutorial. 
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4. Choose from the list of tutorials provided.  

 
Note that three of these tutorials have two stages provided – this is so that you can open 
either a project that is just beginning (as yours will be) or a later stage (to see how a 
project develops). All these tutorials contain detailed instructions for using all the tools 
in NVivo. To follow the instructions for any one of these tutorials will take about three 
hours. 

1. Select one tutorial called “Stage 1”. Click OK. 

An Online Help file will appear, showing each of the steps in your tutorial, and giving 
detailed instructions for you to go through its steps. 

2. Do it! As you work through the tutorial, take notes of any processes you don’t 
understand or want to explore further. You can copy and paste from the tutorial 
Online Help files as you create these notes. At the end of your tutorial session, 
review what you’ve learned by clicking through the tutorial help file topics, which 
show on the top of the help file screen. Check that you have understood the 
following processes which you are about to conduct for your own project: 

• Creating  a project 

• Preparing and importing a document 

3. When you have reviewed your tutorial work, click Close Project to close the 
tutorial. 



 
You were working in tutorial mode, so changes were not saved. In the next stage, you 
will be working with a real project – yours – so another task will be added - saving the 
project you are about to create! 



 

2. Setting up your own project 
The next task is to set up your project with the documents and ideas you created while 
working through Chapter 1. 

To review what you need to know about documents, go to the document you 
downloaded from the QSR website, Introducing NVivo, pp. 4-5. 

(If you have not yet downloaded materials to help you, click here to go back to 
Supporting materials and sources of help .)

1. Whether you just called NVivo, or just closed a tutorial project, the NVivo launch 
pad is displayed: 

 

 
 

2. Choose Create a Project and let the Wizard take you through a “typical” project 
setup. 

3. Type in the name of your project and a brief description: 
 

 
 
4. Click Next> then Finish to complete the creation of this new project.  
5. The next screen displayed is the Project Pad of your own project. On the title bar 

will be the name of the project you created. 
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Using the Online Help 
1. Click in the Project Pad window to select it, and press the F1 key. This is how you 

call the Online Help on any window you are working in.  

  Each Help file window will have further links to explanations of other windows or 
functions. If you get used to moving around these files, you’ll be able to find your way 
around the software rapidly.  
 
2. In this case, to read more about the Project Pad, in the Help window, click on the 

hyperlink from those words…  
 

 
 
3. Now click around the Project Pad on your screen to see how it gives access to the 

places provided for storing your new project. 



3. Saving and seeing your project 
1. Before you move on, select from the Project Pad the button that says Close Project.  

2. You will be asked whether you wish to save this project, choose YES. 

Congratulations! You have a new, saved project, waiting for your data and ideas. 
An NVivo project database is made up of several folders and files.  When the NVivo 
software is installed on your computer, it automatically creates a folder ready to 
store you projects. This folder is C:\QSR Projects. Your new project should now be 
in its own folder stored in this folder.  

3. Go to the Windows Explorer and find C:\QSR Projects. Check your project’s folder 
is inside. You’ll notice that there is also a Backup folder as a storage area for your 
Project Backup files. 

Always close your project before checking its contents via Windows Explorer. 

 

Your project should have folders like this: 

 
 
Every project in NVivo has two main folders –All Users and Database.nv1.  
In the All Users folder you can store your Source Documents, photos or other material 
you will link to (External Databites) and Results of your analysis. A folder called 
Commands is provided for any automating processes. 
 

 Database.nv1 is the crucial folder whose files are in NVivo format. Files here 
should NEVER be opened, renamed or moved elsewhere, since serious database corruption 
may occur. (That’s what the file called Warning.txt says!) 



 

4. Opening and Saving your Project 
 
An NVivo project is saved as a whole either when you go to close the project (as 
before) or whenever you ask it to save.  
1. Start NVivo, and from the launch pad select Open a Project. Your new project will 

show in the list: select and open it. 

It has no data in it – but just to be sure that once it does, you can save it at any time 
that you think it should be saved: 

2. From the Project Pad, choose Project, Save Project from the menu bar or use 
Ctrl+S.   

Make a habit now of doing a Save whenever you feel you have significantly changed 
your project. NVivo will do a temporary auto-save of your project as you work, so that 
if the computer crashes it can restore that stage. And when you close a project, it will 
ask you if you wish to save changes. But in a session working on the project, it is 
always worth doing a Save to update the version on your hard disk.  

As your project progresses, you will need also to save a separate back-up copy. How to 
do this is described in the tutorial for Chapter  

The Project Pad must always be in focus when you are saving your project. 

 

This concludes the tutorial for Chapter 1 of Handling Qualitative Data.  

Now for some data! In the tutorial for Chapter 2, you’ll make documents in three 
different ways – and back up the now growing project. 



Tutorial for NVivo 2 Chapter 2: Qualitative Data 
Chapter 2 of Handling Qualitative Data is about making qualitative data, and this 
tutorial is about how to make data records in NVivo, or import them into your NVivo 
project. There are three ways of doing this – in this tutorial there are instructions for 
each: 

1. Import one or more records from a word processor file; 

2. Work in your project, and type a record there.  

3. Record a summary of what’s in an external record. 

And since at the end of this tutorial you will have a project underway, it concludes with 
instructions for a fourth task: 

4. Back up this precious record of your work! 

To review what you need to know about documents, go to Introducing NVivo, pp. 4-5. 

For more details on preparing and importing data for NVivo, go to the Online Help, and 
the Chapter on Documents/Doing It. Note particularly the advice on applying Styles in 
your document: the insertion of Word’s Heading Styles to mark sections will allow you 
to autocode those sections (see tutorial for Chapter 5.)  

 
Chapter 1 begins with advice on setting up a project, and specifying its proposed 
purpose, goal and outcome.  There are no rules about the documents that will contain 
these reflections and plans, but you are strongly advised to save them safely.  

If you are working in NVivo you can write these early research design documents or 
letters etc. in a word processor and import them to your new project. Or simply write 
them within your project. And you can make “proxy” documents to represent other 
material that you don’t want to bring into the project at all but don’t want to lose. 

http://www.sagepub.co.uk/richards/default.htm#NVivo25#NVivo25


1. Importing a first document 
Most of the data sources described in Chapter 2 will make text. At this stage, these will 
be the early research design documents. Later, they will be transcripts of interviews, 
field notes, survey responses etc. As those documents are created, they are best typed up 
in your normal word processor (here we will assume it’s Word.)  

To bring word processor documents into your project in NVivo, just save in rich text 
format (.rtf) within Word and then import the file. 

 In NVivo 2.0, you will lose any ‘embedded objects’ such as tables or photographs 
from the file. It’s just text that is being imported. So save separately any non-text items 
in your file and use links to them to keep track of these. (See tutorial for Chapter 3.)   

1. Create or locate a document you’ve typed up in the word processor. If you have no 
document, write an informal one about what you are planning to do and call it 
something like “Research Brief”. Save it in rich text (.rtf) format. It’s a good idea to 
save it in the Source Documents folder in your project – so you know where you put 
it! 

2. In your NVivo project, on the Project Pad, click Documents, and choose Create a 
Document. The first option is the default, Locate and import readable external 
text file(s). 

3. Click Next>.   

 
4. Navigate to where your first RTF source file is located. Select the document, and 

click Open. (If you have prepared more than one document, select them all to 
import many documents at once.) 

5. The Wizard offers options to Choose Name: leave the first option, Use the source 
file name as document name… and click Finish. 

Your document is imported.   



6. To see it, go to the Project Pad, then click on Documents and Explore Documents. 
Find your first document, click on it an on the Toolbar click the top left Browse 
icon. Your document will open and you can read the text. 

 

 
7. If you wish, you can edit the text in the Document Browser. Keep writing, or 

change colours and fonts etc just as though you were in a word processor. 

 



2. Creating a document in NVivo  
Documents can also be introduced into a project by transcribing directly into NVivo.  It 
has a rich text editor, and you can type much as you would in a word processor. (But 
don’t expect the full word processor functions like spell checkers!)  

This is the best way to start a “Log Trail” document (p. 43). Once it’s created in NVivo 
you can continue to enter into it all the events in your project that should be logged.  

As you’ll see in later tutorials, there are huge advantages in typing directly into NVivo. 
Your log trail document  can be linked to the data it describes (see tutorial for Chapter 
3). And (see tutorial for Chapter 5) you can code as you type. 

1. In the Project Pad, from the Documents tab, choose Create a Document and select 
the final option, Make a new blank document.  

 

 
2. Click Next> 

 
3. Enter a name for your new document and add a description.  Click Finish.  

A new blank document appears in the Document Browser window. Note that it 
looks very much like a word processor window. You are in NVivo’s rich text editor 
so use heading styles, italics, bold or colour if you wish. 



As noted in Chapter 2, it’s very important to date the entries in your project 
log. You can do this from the Edit menu (Insert Date & Time).  

4. Now write! For this exercise, follow the advice on starting a Log Trail document, 
pp. 43-44 in Handling Qualitative Data. 

5. Close the document as you would in a word processor, from the menu or by clicking 
the corner X. Changes will be automatically saved. 

3. Recording external data  
Now for data that is not easily brought into NVivo. As noted in Chapter 2, qualitative 
data is rarely homogeneous. Much of your data will not be textual.  

For the project you proposed, find some data that you do not want to bring into the 
computer, or can’t – e.g. books, photos, videos, or a box of newspaper cuttings.  In 
NVivo, such data can be represented by “proxy” documents. If the file is on your 
computer it’s called an “external file” because it will not be in your project. If it’s not on 
your computer, it’s termed “non-file data”. 

If you are stuck for some external data, make a proxy for Handling Qualitative Data! 
Any project requires work with literature, and a proxy document is a very useful way to 
reference and keep connections with books and articles. You can type into the proxy 
your summary of a chapter, with occasional quotes, link it to relevant data in your 
project and use coding to find the passages when they are needed. 

1. From the Document tab, choose Create a Document and select Make a Proxy 
Document for non-file data. Click Next> 

2. Type in the location, name and details of the book (or photos etc) you wish to 
represent. Click Next> 

 
3. Choose Use numbered paragraph headers, and then choose which units you want 

numbered (e.g. chapters or pages for a book, tape counts for a video). NVivo will 
make a proxy formatted with a paragraph for each of these units, so you can type 



your summary or comments in the relevant place. Enter the number of those units 
(e.g. first chapter 1 and last chapter 10). 

 
4. Click Finish. 

5. Now to find your new document. Return to the Project Pad and click Explore 
Documents. You will now have (at least) three documents showing.  

 

 
 

6. Select your new document in the Document Explorer, and click Browse. You have 
a template into which you can type the summaries of your external data. Each 
chapter (or other unit that you’ve specified) has its own paragraph, so you can put 
the summary or your comments at the appropriate place. 

7. As before, just type as though you were in a word processor. In the tutorials to 
Chapters 3 and 5, you’ll learn how to link and code this proxy. 

 Note that the Explorer, like the familiar Windows Explorer, will allow you to sort 
on any of the columns in the right pane, so you can view your documents in order of size, 
amount of coding, or date created or modified. 



4. Backing it up! 
NVivo 2 has a single file backup and restore command which makes backing up your 
project much easier. This single file can then be stored on a CD, Zip Disk, Network 
drive or emailed to a supervisor or colleague. 

1. Save and Close your project.  

2. Via the NVivo Launch Pad, choose from the menu bar, Project/Backup 
Project…  

3. Select your project and click the Backup button.  

 
A good trick is to edit the file name to include a date so you can easily find the latest 
version of your project. 

A message will be displayed when the project backup is complete. 

 You haven’t created a secure backup until this backup file (*.qbk file) is copied 
elsewhere!  A backup on your hard drive is a copy not a backup – what happens if your hard 
drive dies or your computer is stolen? 

Use this method to restore a project from backup or if you are transporting a project 
between work and home.  If your supervisor or colleague has NVivo 2 and would like to 
see your project, send them the *.qbk file created in the previous exercise as an email 
attachment. They save the file and use restore to open your project. 
 

1. Via the NVivo Launch Pad, choose from the menu bar, Project/Restore 
Project…  

2. NVivo asks you to locate the backup file. It defaults to the C:\QSR 
Projects\Backups folder. If your backup is on a CD, Zip Disk, Network drive, 
etc, you need to navigate to where it is stored.  

3. Locate the Backup.qbk file and choose Open. Notice that the Project folder 
name is the same as the project name.  

4. Select Open project once restored and click OK.  

You’ll receive a message when the project has been restored successfully.  



You now have a project with data, and a good routine for keeping it safe! In the next 
tutorial, you’ll learn how to store different sorts of information. 

 

Tutorial for NVivo 2 Chapter 3 Data Records 
Chapter 3 is about the ways data are recorded. It emphasizes the importance of making 
good data records. One aspect of this process is to store the context and the sometimes 
complex information that you have, to accompany the qualitative data you are storing in 
transcripts or field notes.  

In this tutorial you will learn how to store information as attributes of the cases, sites or 
individuals you are studying. You will create attributes in NVivo, and then import a 
table of attribute values. And as you will find how to “tidy” the documents into sets. 

To review what you need to know about Attributes and Sets, go to Introducing NVivo, 
pp 8-9 and 14-15. 

As explained in Chapter 3, qualitative researchers usually have data about the “cases” 
represented in their data documents, for example, information about people or sites etc. 
Any data of this sort that you want to be able to work with in your project can be 
represented by “attributes”. You will learn more about the uses of this sort of 
information in Chapter 5, where it is discussed as a “descriptive” form of coding. 

Just as in a survey, you will need to store for each such case the information about 
which value of each attribute applies (for example, gender=female).  

NVivo 2 will store attributes of either documents or nodes. If each case (person, site etc) 
is represented by a document, you record the attributes of documents. If that case is 
spread across many different documents or parts of documents, you code it at a case 
node, and record the attributes of that node. In this tutorial, attributes are stored for 
documents. Go to the Online Help for advice on storing attributes for nodes. 

1. Bringing more data into your NVivo Project 
To start this tutorial, create or import some more documents in your NVivo 
project, following the instructions in the previous tutorial. 
1. Bring into your project at least two more data documents – field notes from 

observations, transcripts of interviews or documents available from other sources. 

2. Now, open your project and on the Project Pad click Documents tab and then 
choose Explore Document Attributes.  

3. An odd-looking table is shown, with all your documents as rows – and no columns! 
It needs some attributes. The attributes will be the columns, and the appropriate 
value will appear in each cell.  

4. Close the window. 

2. Using attributes and values 
You can individually create the attributes and allocate the appropriate value in NVivo. 
Or, if you have substantial amounts of this type of information (e.g. in an SPSS or Excel 
file) it can be imported as an attribute table.  



If you know the attributes your respondents or sites will have (that is, the information 
you’ll want to store), you can create them all now, with their values. But there is no 
need to – they can be created as needed. 

 

If a document represents a person (e.g. an interview with Mary), you can record 
information about that person by giving the appropriate values of attributes to the 
document. If cases are represented by many parts of documents, this is handled 
differently – all those parts will be coded at a node and the attributes given to that node. 
For this tutorial, we will store document attributes. 

Creating attributes in NVivo 
1. Back in the Project Pad, click Edit a Document Attribute. 

 
2. The first option is selected: Create a new Attribute. Type the name of an attribute 

that will be relevant to your data – e.g. Gender. Click Apply.  

3. Select the new attribute (Gender) in the left-hand pane and click the Value tab. 

Note, your attribute has values already! NVivo provides three ways of saying there 
is no information about this document – Unassigned, Unknown and Not Applicable.  
Create a new Value is selected: so type in a value you know your attribute will 
have (e.g. Female) and Click Apply, then continue for other values. Note that there 
is a default value – Unassigned. You can change that if you like e.g. if all the first 
respondents will be women, make the default Female. 

4. Close the Create Attribute dialogue. And back at the Project Pad, choose Explore 
Document Attributes.  This time, the table with your document names has at least 
one attribute as a column. Unless you changed the default value, the cells will have 
dots in them – if you mouse over the cell you’ll find that means “Unassigned”.  

5. Right-click on one of the cells and the values you entered will show, as in a 
spreadsheet. Choose the value that applies to this document.  If you so far have 
imported no files for which it would be appropriate to record attribute information, 
use the N/A value. (e.g., your Log Trail Document has no gender.) 



6. When you find a document with the value of an attribute not yet created, simply 
right-click in the cell, choose New Value and name the value needed. Note this new 
value now appears each time you right click in a cell. 

 Note how often attributes appear in the menus and the attribute icon  appears 
in the toolbars. You can get to the attributes of documents from most windows – for rapid 
checking (was this a woman speaking?) You can also check attributes for individual 
documents via the document browser rather than going back to the Attribute Explorer. 
This can be useful if you are coding a document and need to check information about this 
group or participant. And attributes are always available in the search processes that will 
be explored in the tutorial to Chapter 8. 

Using Attribute Tables 
Such information of course is best displayed in a table, and you can explore the 
attributes in the table but export and import them via any program that handles tables 
(spreadsheet, data base, statistics package.)  

Exporting attribute tables 
As you work in the project, you will wish to view the attributes of the documents, or 
perhaps to display them visually for reports. You can print the table accessed above, or 
it can be exported for further entry in a spreadsheet or stats package.  

1. With the table on the screen, choose File>Export to export the table. Notice that 
the default folder for saving this file is the Results folder of your project.  

2. Name the file appropriately, The table that you have exported can be opened in 
Word, or Excel or just about any table handling software.  

Importing attribute tables 
An attribute table can be created “outside” NVivo and imported.  If you have a lot of 
attributes and documents, this is more efficient than creating them in NVivo.   

1. Type a small table in Word or Excel, with the word “Documents” in the first cell, 
and the names of your documents down the side. 

Make sure that the document names are the same as the names of the documents 
in your NVivo project that you want to give these attributes to. 

2. Type names of attributes as the headings of the columns.  

3. Type into this table the names of the values for each document, at each attribute. If 
the attribute isn’t applicable, leave the cell blank. 

You will have a table that looks something like this. 

Document Gender Age Income Education 



Log Trail     

Literature review     

Interview 1 Female Under 20 None High school 

Interview 2 Male 20-30 Middle  tertiary 

 

4. Now save that table as plain text, tab-separated. (In Word, go to 
Table>Select>Table, then Convert>Table to text and choose Tabs for separation. 
Now Save As plain text.) Save it somewhere you will find it again – e.g. in the 
Commands folder provided in your project for any automation tasks you may 
conduct. 

If you open the file you saved in Word, you’ll find it looks a lot less tidy: it has the 
same content as the table you saved, but the cells are marked by tabs rather than neat 
lines. This is the version that NVivo can import! 

 
Document Gender Age Income
 Education 
Log Trail     
Literature review     
Interview 1 Female Under 20 None High 
school 
Interview 2 Male 20-30 Middle 
 tertiary 
 
5. Back at the NVivo Project Pad, go to the top menu bar, and choose 

Documents>Import Document Attributes… 

6. Click the Choose button and navigate to find the file you saved. Read carefully the 
window on your screen – unless you change any options, NVivo will create any 
documents, attributes or values that your project doesn’t already contain.  

7. Click OK and the import process will commence. A message will be displayed to 
advise that the import was successful. Click OK.  Now to check what you’ve done, 
click on the Project Pad and select Explore Document Attributes.  



 
8. Click around the table. To assign values, or create new ones, right mouse click.  

 Note that as discussed above, if the cases for which you have attribute 
information are not represented by a single document, you have the option to import 
attributes for nodes.  

3. Using Sets 
This tutorial finishes with the simplest way of managing your data records in NVivo, 
Sets. Whilst these are very easily made and used, they are also ways of doing the most 
subtle and powerful searching processes. 

Sets can be created and changed in your project either in the Explorer or in the Set 
Editor. Here we simply use the Document Explorer. If you want to find out more about 
the ways you can work with sets, go to the chapter on Sets in the online Help. The Set 
Editor, and the way it can scope searches, are covered in the tutorial to Chapter 8. 

Making a document set 
1. At the Project Pad, click the Documents tab and choose Explore Documents.  

2. Consider the documents you have brought into your project, and identify one 
group that could be usefully held together in a set. (For example, all your 
interviews.)  

3. Select the Sets icon in the left-hand pane. Right-click and choose Create Set.  

4. Click in the name (currently Untitled set) and rename the set, e.g. Interviews. 
(or go to Properties and rename it and add a description).  



5. Click on the All Documents folder and drag the documents that are interviews 
onto that set. Notice, they are still in All Documents! When you click on the set 
you will see that it contains icons indicating “short cuts” to the interview 
documents.  

 

 Because shortcuts, or pointers to the documents go into your sets, you can put a 
document in any number of different sets. Think of other ways you could group your 
documents. For example, Interview 1 might also belong in the set of documents from last 
year. 

6.  Think of useful groups for your data records, and make sets for them – whether 
or not the records are yet in your project.  

 For most qualitative projects, a useful set is of documents that will contribute to 
your “log trail”, your growing account of the project and how it is conducted. Visit the final 
chapter to read about the task of doing a “stock take” of your writings about the project. 
This will be much easier if there’s a pointer to each relevant document in a set called “Log 
trail documents”. 

You now have a project with data documents and information about their context, and 
have started managing those records in sets. Time to back up. Follow the instructions in 
the previous tutorial to store a safe copy of your project.  
In the next tutorial, you’ll turn to skills for discovery and handling of ideas that come 
from the data. 
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Tutorial for NVivo 2 Chapter 4: Up from the Data 
Chapter 4 in Handling Qualitative Data  is about the exciting processes in qualitative 
research involving discovery and exploration of ideas from the data. 

In these exercises, you will work with just one document in your project, to explore the 
processes of “taking off” from the data. 

As you read the record, and discover new ideas, you will try different ways of storing 
these in software.  

To review what you need to know about the different ways of storing ideas and different 
sorts of links, go to Introducing NVivo, pp 10-11. 

1. Focusing on a document 
To start this tutorial, select a document in your project, print it out or browse it on 
the screen, and really read it. Now, go back to the start of that document. 
This time read the text very thoroughly, line by line. As you find material that is 
interesting, conduct the exercise on “Taking off from the data” (p.70f.). 

In turn, the following exercises use each of the ways of storing ideas about the 
document (pp. 73-75.) In the tutorial for Chapter 5, the processes of coding will be 
described. Normally, researchers combine the storing of ideas with the creating of 
categories and doing coding – but for these early steps, it is useful to take them 
separately. 

• Annotate it. 

• Write about it in a memo.  

• Link it to related data. 



 

2. Browsing and annotating a document 
1. In the Project Pad, click Explore Documents.  

The Document Explorer opens. Select the document you wish to read. Note that if 
you click on it on the left side, you see its outline (the sections you have marked 
with headings.) If your document has sections, you will be able to autocode it in the 
next tutorial. 

2. Click Browse on the Toolbar.  

 

 
 

The document opens in a Document Browser. This window allows you to edit, 
annotate, create memos and (see next chapter’s tutorial) code. 

 



 



3. Annotating 
3. Select a bit of text that requires a comment. In NVivo 2, you add “bites” of data 

to your text via links called DataBites. Click the  Make/Inspect DataBite icon 

on the toolbar  .  

 
4. Select the type of DataBite to create – note that it could be an annotation, a link 

to a file outside your project (such as a photograph) or to a web page.  

5. To annotate, select Internal Annotation. Click Create… Type your reminder 
or comment and click Save and Close.  

Back at the text you selected, you’ll notice it is now marked as the DataBite 
“anchor”, coloured green and underlined.  

6. Right-click inside this “anchor”and choose Inspect DataBite to view your 
annotation.  

 



4. Writing a memo 
Memos are full status documents that NVivo sees differently from other documents only 
because you label them as memos.  

As described in Chapter 4, you can use memos to capture thoughts and insights you 
have when you are working through your data.  The computerized equivalent of a 
notebook, they are great tools for noting down possible themes and concepts that you 
want to go back and explore later on.  But unlike the notebook, they can be linked 
directly to the text that gives you an idea, or the place you store it. 

Memos are editable rich text documents in NVivo and the simplest way to created them 
is to ask to link to a memo from any other document.  You can also create memos 
simply by making a new blank document (see Chapter 2 tutorial) and in its Properties, 
clicking the box that says it is a memo. 

It is very easy to make a memo from the text of a document. 

1. Place your cursor at a point where you would like to link your memo. Choose 
the Make/Inspect Doclink icon on the toolbar.  

The In-Text DocLinks dialogue is displayed – note that it will let you link to any 
existing documents, or make a new memo. 

2. Choose Link a New Memo – and you have a new blank document that you can 
edit as you wish. (this is the quickest way of making a document in NVivo!). 
Write what you wish to record – and go to the Edit menu to select Insert Date 
and Time, to date the current entry. If you do this every time you add to the 
memo, it will provide a good contribution to your log trail. When you have 
finished writing, close the memo and you are returned to the DocLinks window. 
Click Close.  

3. Back at the document, you’ll notice you now have an icon  that represents a 
DocLink. Right-click on this icon to browse the memo  

 

 
 

4. Explore Documents and you’ll notice that your new memo document has been 
named by the document it was created out of – e.g. ‘Interview 1 - Memo’. It is 
listed with all other documents but its icon has a “notebook” appearance.  

5. Select the memo in the Explorer, then click the Properties button in the toolbar, 
to rename the document to represent the theme, e.g “Interviewing as a method” 
and perhaps change the colour of the memo icon.  Now you can return to it at 
any stage to add more ideas, or link to it from any other place in a document.  



 



5. Linking to related data. 
As you reflect on your data document, you may wish to link to other material that is not 
in your project.  

This material can be in a file that is on your computer (in any other software) or a 
website.  

1. To make such links, go through the steps for annotations, above. This time, 
choose to make a link to a file.  

2. When you click Inspect DataBite, that photo or web page will open.  

 

 
Now the data records are becoming “richer”, with your own ideas and the links to 
related material.  



6. Drawing it – the early uses of models 
In Chapter 4, there are suggestions for first uses of simple models as ways of sketching 
and exploring what you think you are seeing in the data.  

You may wish to try these techniques by jumping to the tutorial where NVivo’s model 
tools are covered - in the tutorial for Chapter 7.  
 

 
 

This concludes the tutorial for Chapter 4 of Handling Qualitative Data.  

You now have data, ideas about your data and a rapidly growing project. Remember to 
back up before you exit this tutorial!  

For most researchers, at this early stage in a project, the next task is to start gathering 
material according to topic. For this purpose, you need to code. Chapter 5 is about 
qualitative coding, and in the next tutorial you’ll learn many ways of doing coding. 

 

Tutorial for NVivo 2 Chapter 5 Coding 
Three sorts of coding are described in Chapter 5 of Handling Qualitative Data. 

Techniques for doing the first, descriptive coding, were described in the tutorial for 
Chapter 3. It showed how to create attributes (e.g. gender) and assign the relevant value 
(e.g. female) to each case in your project. Revisit that tutorial for techniques of doing 
this manually or by table import. 

http://www.sagepub.co.uk/richards/default.htm#NVivo27#NVivo27


This tutorial shows techniques for doing the more “qualitative” coding of the data by 
topic, or to identify new categories and ideas in the data. In it you will learn to: 

• Create nodes from prior ideas  

• Code at existing nodes  

• Create nodes and code “up” from meanings in the data  

• Automate by section coding  

• Code by text search  

and most significantly, because this was the reason for doing all that work: 

• Browse and work with coded data.  

To review what you need to know about nodes and coding, go to Introducing NVivo, pp 
6-7 and 12-13. 

1. Focusing on a document 
To start this tutorial, as with the previous one, you need to concentrate on one 
document in your project. 

It may be the document you worked with in the previous tutorial – it’s interesting (but 
not necessary) to combine the writing and linking techniques there with those of coding. 
If you want to move to a different document, read it through before you begin coding on 
computer Now, go back to the start of that document. 

1. Making a node 
Chapter 5 explains the uses of coding in qualitative research, and the many ways 
researchers create categories, “down” from their research questions and designs or “up” 
from the data. In NVivo, those categories and the coding you do are stored at nodes. 

7. In the Project Pad, click Nodes and then Explore Nodes. The Node Explorer 
opens, offering different areas for nodes “free” of organization or in catalogs of 
“trees”. The next tutorial covers the managing of nodes in trees: here we will 
code just at free nodes.  

8. On paper, or on a white board, sketch a beginning list of the categories your 
project is about – topics or ideas about which you wish to collect data. (For 
example, in this mythical project about the qualitative research class, an issue 
under enquiry might be students’ fear of the flexible nature of the project – too 
few rules!)  

9. Click on Free Nodes, right mouse click and select Create Free Node.  



 
10. To rename the new node, as above, click on it (it’s called “Free Node”), and 

click Properties on the Toolbar. The node properties box opens and you can 
type the name of your node.  

11. Continue creating and naming nodes for any topics or concepts your project will 
require.  

  Note that the Properties box always offers the opportunity to describe the node 
– a good place to store hunches or first thoughts about the category. At any stage you can 
print off a list of all your nodes with their descriptions to assess or discuss (just go to 
Nodes on the top of the Project Pad and select List all Nodes and ask for descriptions 
also.) 

2. Coding at an existing node 
1. In the Project Pad, click Explore Documents. In the Document Explorer select 

the document you wish to read. Click Browse on the Toolbar. This window, in 
which you annotated and linked a document in the previous tutorial, also offers 
several ways of coding.  

2. Display the Coder by clicking the  Coder icon in the “Coding Bar” at the 
bottom of the window. Rearrange the Coder so it’s displayed on the right-hand 
side of the screen.  

3. Double-click on Free Nodes to show your nodes.  

4. Select some text about one of these categories, select the node, and drag the 
node in the Coder to that text. (Or drag the text to the node.)   



 

 Note that the node is now bold – this shows it has coding. It is a useful habit to 
scan the nodes you create, watching for the ones that are not bolded, and wondering why 
they don’t have coding. 

You may wish to continue reading and looking for data about the categories for which 
you already created nodes. But those prior categories will probably not suffice for what 
you are now seeing in the data. You need to create nodes “up” from the text. 

3. Creating new nodes “up” from the data 
As you read on, you may see a category “emerge”.  You can first create the new node in 
the Coder (just right mouse on Free Nodes and create a new node as before in the 
Explorer.) But it is quicker to use the coding bar on the bottom of the Browser. 

1. Highlight some text you wish to code. Type the name for this node – the 
category or theme – in the slot on the coding bar (to the left of the Code button). 
Click Code. The node is created and the coding done.  

2. Highlight a word in the text with which you would like to name a node. This is a 
technique called “in vivo” coding. It’s useful when the data provide specially 
suggestive or meaningful concepts – for example, here the student mentioned 
needing “recipes” for research processes. Click the “In-Vivo” button on the left 
of the coding bar. Again, the node is created and the coding done.  



 
3. Continue, creating nodes as they are indicated in the text, for either topics you 

wish to collect data on, or concepts you wish to explore.  For each new category 
you create, write a description in its Properties box.  

4. Automating coding of sections 
The tutorial for chapter 3 covered how to automate descriptive coding by importing 
attributes in tables. Coding of text is a more subtle process, since it involves creating the 
node, selecting the text to be coded there and doing the coding. But there are two ways 
of automating coding of text.  

• by section coding, using the formatting of the document  

• by text search, using the occurrence of words in the text.  

 Both are ways of sending the software to do a mechanical process, using either 
your formatting or the words. Check the warnings in Chapter 5 about interpreting 
mechanical coding! These methods may not be appropriate to the data you have so far in 
your project.  

In this section, we deal with section coding (go to the next section for text search). 

You may have used headings and subheadings in your documents, (for example, in the 
interviews in screen shots for these tutorials, questions being asked are always typed in 
Word as a Heading 1.) NVivo recognizes these headings. The text between headings 
can be coded automatically using section coding. 

1. You need to make a node below which all the question nodes can be stored. This 
will go in the Trees area of the Node Explorer. Click on Trees, and right 
mouse to create a node.  



 
2. Select the new Tree Node, go to its Properties and name it “Questions”. 

3.  In the Document Explorer, select the document with sections to be coded (or 
All Documents, if they all have sections that are the same), right mouse and 
select Code by Section. 

 
4. The Section Coder opens, asking for the node that will be “parent” to your 

section nodes; click Choose, select your Questions node and click OK.  

 The section coding is (probably!) reported as successful. Note, this does not mean 
that the results are as you expected – you’ll need to check that! Go to the Node Explorer 



and click on the “+” at the Questions node – you should now have a node for each section, 
named by its header, and coding all the text under that header until the next header. 

 

5. Automating coding by text search 
Now to meet NVivo’s Search Tool. Here it is used just for searching for text in 
documents. For a fuller coverage of the many ways you can search coding, attributes 
and text, go to the tutorial for Chapter 8. 

1. On the Project Pad, click  In the Search Tool click Text.  



  
 

2. Type in a word to search for (one that will be found in your data.) 

 
3. Ignore the advanced options, for now. Note that the finds will be saved as a 

node. Click OK. Check the two lower panels on the Search Tool. The Scope of 
the search is All Documents. (Leave it that way.) And you have the option to 
Spread Finds. Change this to Enclosing Paragraphs  

 
4. Now click Run Search. The search is completed and a window tells you where 

the results are stored – in a new node (called Single Text Lookup), under Search 
Results in the Trees area of your Node Explorer. Check the Node Explorer and 



you will see the text search node, complete with a description. NVivo has coded 
there all the paragraphs where the text you specified was found.  

 

 As you get used to the Search Tool, you may do many such searches. A very 
useful habit is to rename the nodes created to code the results, so you can recognize 
them. 



Browsing coded data 
A strong message in Chapter 5 was that coding must be purposeful. You have now 
created nodes and coded at them in three different ways – with the result that material is 
now gathered at those nodes. As the project continues, you will find more material 
about nodes you’ve created (e.g. “fear of flexibility” or “recipes”) and code again at 
those nodes. Or you will conduct another interview using these same questions and 
section code it at the same nodes. Why? Always, if you are coding qualitatively, one 
reason is that you want to read all that material together. Now to browse the node, so 
you can read what’s coded there, think about it and work with it. 

1. In the Node Explorer, choose one node, at which you have done some coding. 
Click Browse.  

2. The Node Browser opens. It looks very similar to the Document Browser, with 
a coding bar at the bottom, and text in the window. But note, there are no editing 
buttons or menus. You are looking at all the text segments coded at that node, 
and if you wish to edit or annotate, you’ll need to go back to the document.  

3. You may find that there is very little text coded at your node – NVivo is 
showing you just only what you coded. If you used “In-Vivo” coding, you may 
have only one word there – the one you selected to name the node! Right mouse 
on it and select View Section. The enclosing text shows in green.  

 
4. Select what context you’d like to code to make sense of it. Your node is waiting 

in the coding bar – just click Code.  

5. Remembering the emphasis on keeping context of qualitative data, you may 
want to ask, where did this passage come from? To go to the document from 
which it’s coded, right mouse click on a passage and select Browse/Edit/Code 
Document – this will jump you to the document at that passage – and you can 
keep working there.  



 Maybe you want to code some more context from the document, or place a memo? 
Note if you annotate or place a link in the coded text, when you return to the node, those 
links will show live there. 

 
6. Now perhaps a new idea occurs – this text suggests a different category? You 

can code just as you did in the Document Browser: click Coder, make nodes 
and do coding. You are now coding on from the first coding, a very important 
process in refining qualitative coding.  

Continue, reading and coding your data, browsing your nodes, expanding or revisiting 
context of coded passages, coding-on to make new categories. 

This concludes the tutorial for Chapter 5 of Handling Qualitative Data. You now have 
data, ideas about your data and have started to relate them by coding data at those 
ideas.  

Don’t forget to back up your project! The next task is to manage those growing ideas, 
and this will change your project dramatically. 

 

Tutorial for NVivo 2 Chapter 6 Handling Ideas 
If you don’t organize and manage ideas, you will almost certainly lose them. Or worse, 
you will lose them sometimes. Chapter 6 of Handling Qualitative Data is about ways of 
cataloging ideas and categories that are part of the research design or emerge from the 
data. These tutorials are about how to do it by cataloging in trees the nodes that are 
containers for your ideas in NVivo. 

As you work in your project, you will find that coding data or exploring relations of 
ideas always requires finding nodes, and seeing their associations. In other words, in 
order to bring data and ideas together, and create new understandings, data management 



is necessary – as in most areas of qualitative method, efficiency is necessary for 
creativity.   

Revisit the tutorial for Chapter 5 if you need to review the ways of creating, naming and 
describing nodes. 

To review what you need to know about nodes and managing them, go to Introducing 
NVivo, pp. 6-7 

1. Reviewing nodes 
1. On a whiteboard or very large sheet of paper, review the categories created so far. 

Do you see the categories needed for thinking about your project there? If not, 
sketch in the other categories you think you will need. 

2. Now in your NVivo project, open the Node Explorer and review the free nodes you 
have created so far in your project.  

• Are they named accurately and described adequately? Click Properties to 
change any name or description.  

• Are there more categories needed to ask the questions or explore the issues you 
are tackling? If so, create the nodes.  

3. Do they belong together in any logical order? Don’t force it! On the paper or 
whiteboard, sketch the shape of a starter catalog that looks logically sensible. If a 
category doesn’t belong with others, leave it free. 

• Looking “top down”, from your project design; what are the main areas of 
enquiry? Revisit the categories you started the project with (Chapter 1).  

• Working with your “data up” categories, ask what they are a “sort of”, and if 
some group logically, note this.  

2. Rearranging nodes 

At this stage, you can make major changes to your project. You did back it up at 
the end of the last tutorial, didn’t you? 

You can cut or copy, and attach or merge, any node in NVivo, without losing any of the 
data it contains. So if your nodes now could be catalogued, the steps are simple. 

1. Back in your NVivo project, go to the Node Explorer and create nodes in the Trees 
area for the main categories you have sorted your ideas into. These new tree nodes 
will be “parents” for the subcategory “children” that belong there – these are the 
nodes that are a “sort of” the parent. Thus my node for “fear of flexibility” might go 
with other categories about “concerns about qualitative research”). Create any 
parent nodes indicated by this review.  

2. Go to the Free Nodes you created by coding in the previous tutorial. Select one that 
properly “fits” as a “sort of” one of your new parent nodes.  Right mouse click and 
Cut the node from the Free Nodes area. 



 
3. Go to the parent tree node you want to catalog the cut node under. Right mouse and 

select to Paste the node. Click the “+” and you will see your newly rearranged tree. 

 

 If you prefer caution, Copy, and then when you’re sure it’s pasted correctly, 
Delete the free node. You alternatively can drag the from Free Nodes to the new position 
and this will copy.) 

4. Continue cutting and pasting nodes as indicated by your review, until you are 
confident the arrangement is logical and that it does not in any way force your 
thinking about the categories or pre-empt things you might later find. (Chapter 6 
advises on use of catalogs avoiding these traps.) If a node doesn’t logically “go” in a 
tree, leave it free.  

5. Now code another document, working with the categories as they are now arranged, 
so you can find existing ones and place new ones. You will find that as you work 
with the nodes, now, it is very easy to cut or copy and paste or merge as the system 
of nodes starts making sense. Now do these moves in the Coder (exactly the same 
mouse-clicks as in the Explorer). 

6. Visit the categories you have left “free” of the catalogue and review them. 

 A good habit is to review nodes left “free” often – as the catalog forms, the 
remaining Free Nodes are special. They are the categories that don’t fit anywhere. Maybe 



they are just irrelevant? But maybe they are the still unconnected ideas that will become 
crucial in making sense of the more organized thinking about your project.  

2. Listing nodes 
1. Now to get a report on the node catalog you have created! Return to the Project 

Pad, and from the Nodes menu, select List all Nodes (you can select to have 
descriptions reported for each. 

 
2. Read the report, and if it is useful, from the File menu select to save it. The default 

location for the rich text file that is saved will be the Reports folder in your project 
folder, eg. C:\QSR Projects\First Try at NVivo\All Users\Results 

 The catalog of your nodes that you create now will change, as your understanding 
of what’s going on in these data records grows. So the node system at any time will be an 
excellent record of where you are “at” in the project. A highly useful technique for logging 
progress is to save and archive a list of your nodes at regular intervals, or at significant 
milestones in the project. 

3. Make a new blank document and write a memo about this first stage of catalog 
construction. 

4. If you are working in a team, discuss and design a common catalog of categories 
and discuss how you will use it to ensure consistency but allow innovation. 

This concludes the tutorial for Chapter 6  of Handling Qualitative Data. You now have 
not only data and, ideas about your data, but also an evolving management system for 
those ideas. Time to back up your project!  



As you continue relating data and ideas via links and coding, the ideas will be 
accessible for review and reflection.   

If the reorganization of your nodes is satisfactory, you will now be able to “see” the 
logical groups of concepts and categories that are emerging in the project via the 
catalogs of nodes. But the catalog does not show the theories you are growing about 
how these categories relate. The next task is to represent the project visually in a model. 

 

Tutorial for NVivo 2 Chapter 7 What are you aiming for? 
The discussion in Chapter 7 of Handling Qualitative Data is about ways of revisiting the 
project’s purpose, goal and intended outcome, considering possible and useful outcomes 
for your project and seeing the ways to get there. For these tasks, you need many of the 
skills in the tutorials so far – memos, coding reviews and work on the node catalog. But 
almost certainly you also need the ability to draw and show models of what is going on, 
and what is aimed for.  

This tutorial shows how to create layered models indicating the possible outcomes and 
how they would work for your project. 

To review what you need to know about models, go to Introducing NVivo, pp. 18-19. 

 As you start working with models, carefully distinguish between the purposes of 
node cataloging and modeling. A catalog shows how, logically, your categories are related. 
In a model you show how, in the project data, or your hunches and predications about that 
data, or the theory you are creating, those categories may relate. 

1. Making a model 

1. On the Project Pad, click Explore Models  

2. A new model opens. You can put into it any document, node, attribute, value, set 
or model. The icons for these items are on the Toolbar – just click the icon and 
selected the item wanted (or click in the model, right mouse, and select to add 
that item).  

3. Make a first model about the stage you are at – perhaps about what has currently 
been logged. Place in it the items relevant to your work, and link them by 



clicking on an item, then an arrow, then the item you want to link to. 

 

2. Layering a model 
You can make a model that is accessible layer by layer, to tell the story of your 
interpretations of the data, or to compare different views. To do this, you simply 
nominate which of the items in the model belong to which layer. 

1. Go to Tools and Layers, then click New.  

2. Type in a title and description for your new layer. Click OK.  

 
3. Now from the View menu select Layer Palette. Select the First thoughts layer. 

Go ahead to add the items and the arrows to model the first thoughts you are 
taking into the project. If you click to “untick” that layer in the palette, the items 
disappear.  



 
4. If appropriate, make a second layer and in it place the “story” or map of your 

early research. Perhaps the first interview changed your views? Note that if you 
“untick” all layers in the Show Layers palette, then in turn tick each layer, you 
can now show the evolving story.  

  Layering models in this way provides a very impressive presentation format for 
qualitative research. Each stage can be shown and discussed, and at any point, since the 
items are “live” to the data, you can show your audience the detail of the data. As an 
exercise, present the modeled story of your project so far to colleagues. 

 
This concludes the tutorial for Chapter 7 of Handling Qualitative Data. You now have 
data, linked to other material and to ideas via coding. You have organized your ideas 



logically in catalogs of nodes and modeled the beginnings of notions about how they 
might relate in the data.  

Don’t forget to back up your project! At any stage you can of course delete or alter the 
models, but when models represent the story of the project it’s highly advisable to leave 
them as an honest record of where you were. They will become part of your log trail.  

The next task is to use the ability to search your documents and your coding in order to 
develop those growing ideas.  

 

Tutorial for NVivo 2 Chapter 8 Searching the data 
Chapter 8 of Handling Qualitative Data is about the ways of searching text and coding, 
and their uses (and important issues in interpreting searches.) This tutorial is designed to 
assist you to learn the range of search techniques and try them in your own data. 

In the tutorial for Chapter 5, the Search Tool was first introduced. There, the interest 
was in searching text, and the exercise showed how a search results in coding.  

Any search in NVivo is a way of coding data, because NVivo automatically saves and 
codes the results of your search. For any search, the process is the same: 

• ask a question in the Search Tool  

• direct it to the scope you wish to focus on  

• select the spread of context to retrieve  

•  run the search.  

The result is a node, that codes all the finds in that selected spread. 

To review what you need to know about searching text or coding, go to Introducing 
NVivo, pp. 20-21. To review what you need to know about Assay, go to Introducing 
NVivo, pp. 16-17. 

1. Using the Search Tool 
As your project progresses, you will return to the Search Tool for very many different 
purposes. This is where you find occurrences of words, check who is using them, look 
for patterns in your coding, test hunches and seek new ideas. 

For now, identify an area of your project where you could pursue a hunch or question.  

1. State what you are asking in ordinary language, (see pp. 152-153) and then plan 
the searches that would ask it.  

2. On the Project Pad, click .  Click around the buttons and press F1 
for Help to obtain an explanation of what each search will do. Use the Help 
Contents to locate the different descriptions under Searching/Doing It.  

Read the description of the Boolean Searches. 



 
3. Now in the Search Tool, click Boolean, and from the list at Operator, select 

Intersection. This is the “and” search – it will find for example:  

• any text coded at one node and another; 

• any place where a text string is found and that text is coded at a node, and 
the attribute gender = female. 

4. Think of such a question that could be usefully asked in your data. Click on the 
buttons to add to the dialog the text, node(s) or attribute value(s) you want 
included in your “and” search. (The selections below will find anywhere text has 
been coded at the node for “recipes” if it comes from a document with the 
attribute gender =  female.)  



 
 

5. Now check the Scope for this search. (Leave it as All Documents.  

6. Click Run Search. As for the text search you conducted in the tutorial for 
Chapter 5, the results are saved as a node, stored at a Search Results node in the 
Node Explorer.  

7. Having the results as a node means that you can work with them like any coded 
data, returning to the context of the coded segments. Browse the node where 
your results are stored to find what was coded at that node, in documents given 
that value of “gender”. Work with them to interpret the finds, perhaps write 
about them in a memo.  

 Check the warnings in Chapter 8 about interpreting these very powerful searches. 
Note that you can’t claim you have found everything the women think about having 
“recipes” for research processes. The node codes only what the documents that have been 
given that value of gender, record was said in those interviews; and then only what was 
coded (by you) at that node. If the search didn’t find something it should have, it’s 
because you didn’t code or attribute fully. 

2. Scoping your search 
As you use the Search Tool more freely in your project, always ask where you would 
like this search to “go” – what data records do you want to focus on? You can set the 
Scope for any search to any existing set of documents or nodes. In this way, you can 
send NVivo to search any part of your data records that you wish to look at. 



1. Return to the Search Tool, and in the Scope panel, this time select a different set 
of documents (e.g. your set of Interviews). Note you can also set the scope to a 
set of nodes (e.g. to all the data coded at any nodes about learning problems, if 
you had made a set of those nodes.)  

2. Run the search again and check the difference. Note that the search results node 
always has a description recording what scope was searched.  

Assaying the scope 
As you move on, working with your data, it will often be useful to check what’s in the 
scope of a search. For example, if you are searching all your interviews, how many of 
them are with women?  

1. In the Search Tool, click Assay Scope.  

 
2. Select the items you’d like to know about, and below the folders will appear the 

proportion of your scope set to which this item applies.  

3. Select some characteristics to make a table showing which documents in your 
scope have these characteristics (e.g. which have the value of an attribute or are 
coded at a node).  

 



 Assay is available in the Document and Node Explorers as well as from the Search 
Tool – so at any stage you can ask to see the characteristics of your data. Tables are a 
very useful way of checking how your coding is progressing, for example, or which nodes 
are being overlooked. 

Changing the scope by creating new sets 
You can scope a search to any data at all, whether or not you have created a set to 
identify the records you want to search. To do this, return to the Search Tool, and click 
New Document Scope. 

The Set Editor window opens. Here you can ask more questions about your data records 
using the filter, and make a new working set of documents or nodes to select exactly the 
data you want to search.  

1. In the right pane is the set you are currently asking to search. Use the pull-down 
list of sets above the pane to change that to Working Set.  

2. Now explore the panel below that allows you to Filter Documents. If you click 
in the All Documents pane, and select a filter (e.g. as below, Document is 
coded by a node), then click Select. The documents filtered are highlighted. 
Click Copy to list them in the working set. Or simply select a document and 
Copy it into the working set. Use the icons above those panes to Save that set, if 
you wish to keep it, or simply go to Search just those documents.  

 



3. Using Search for your project 
No tutorial can lead you to the searches you need for your own project. Now that you 
know the basic tools for searching text or coding, you need to set out in plain language 
the searches you would like to do at this stage in your project. 

1. Make a table whose first column is of plain language questions to ask in the 
Search Tool.  

2. In a second column, record the search operator to be used. Use the online Help 
to locate the Boolean or Proximity operators that will get at the answer to your 
questions.  

3. In a third column, record the scope to be set for the search.  

4. Run these searches, and record in a fourth column what you learned.  

 Of course you must back up your project, but this time, before you do so, tidy it 
up. You probably have many search results nodes from playing with the Search Tool. Write 
in a memo about what you learned and delete these records of searches you don’t need to 
keep. If any search results nodes are to be kept, a good habit is to rename them sensibly, 
and move them (using cut and paste, as in the Chapter 6 tutorial). 

This concludes the tutorial for Chapter 8 of Handling Qualitative Data. You now have 
data, linked to other material and to ideas via coding, and know how to make catalogs 
of nodes and models to show logical and theoretical relations, and how to search the 
records and their coding.  

The next task is to use the ability to search your documents and your coding for 
different purposes, to show and interrogate patterns. 

 

 

Tutorial for NVivo 2 Chapter 9 Seeing a whole 
The issues covered in Chapter 9 of Handling Qualitative Data are about ways of seeing 
the “big picture” of your project, either in an overall “story” or a pattern. 

Many of the software techniques taught in earlier tutorials will be used at this stage, and 
of course your writing in memos will be all important. But one particular search 
technique is often critical for seeing or exploring synthesis or patterns. This tutorial 
teaches just that one technique – making qualitative matrix displays – and how to use 
them in your project. 

To review what you need to know about the uses of the Search Tool, go to Introducing 
NVivo, pp. 20-21. 

1. Qualitative crosstabulations – the idea of matrix 
Tables are a very familiar way of showing the relation of one lot of features to another. 
In your project, you may be looking for a pattern of how people’s ideas vary by a 



demographic characteristic, for example, or how one group of nodes pattern “onto” 
another, as represented by your coding.  

In the following example, the matrix created will show how the coding at selected nodes 
is patterned by the education level recorded for the interviewee. 

Start this tutorial by asking which of the “seeing” processes you are exploring in your 
project could be assisted by matrix display. As before, write the question in plain 
language first.  

My question here, (in this highly inadequate early stage in my project!) might be: “does 
having done qualitative research in previous courses show any association with people’s 
ideas of problems in using qualitative methods?” I’ve an attribute for previous courses, 
and values allocated (return to the tutorial for Chapter 3 if you need to revise 
attributes!): 

 

2. Making a matrix 
1. Open your project and the Search Tool. Click the Boolean… button.  

2. Choose the operator Matrix Intersection. Clear any Items that may be 
displayed from a previous search so as the right-hand pane is empty.  

3. Click on Choose Nodes to find text referenced by each of the nodes you want to 
make rows in your matrix…. Select the nodes you require and for each click 
Add. (To select all the “children” of a node, click on the parent node and click 
Children.) Check that the right box now shows the nodes you wish to have as 
rows. Click OK.  

4. Back at the Boolean Search dialogue, click the Choose Attribute Values button 
in the second pane. Click on Document Attributes and in the left-hand pane, 
select an attribute and move the values wanted to the right-hand pane by clicking 
the  button.  



 
5. Click OK.  

6. Notice that the search will Return a set of matrix nodes and that the name of the 
node will be /Search Results/Matrix Intersection.  

7. Click OK to return to the Search Tool dialogue. There, click Run Search.  

8. In the Search Completed box, click OK.  

The table will display, with cells showing the number of documents coded at each. You 
can change this to number of characters or number of coded passages. Examine the 
table and ask whether the display surprises at all. And be very skeptical of what it 
shows, especially if your study is still as small as the one illustrated here! 

 



3. Browsing the cells 
For most qualitative research, the critical purpose of building such a table is to 
return to the data and try to understand and interpret the pattern. 

1. Right-click or double-click on any cell. Each cell is a node, so you can ask to 
browse the node.  

2. You are in the now familiar node browser, from which you can jump back to the 
document, view the wider context or code on to new categories.  

3. Using the matrix in reports 
As you move through the processes of “seeing” the project, matrices may be very 
important. You can keep them as nodes in your project, and view on the screen at any 
time – click on the node in the Node Explorer and select Inspect Matrix Table. 

 
In your class report or project write-up, you may wish to include this table. When you 
have the table version that you wish to export on the screen, select File>Export. This 
will export a file that will be saved in the Results area of your project and can be opened 
in Word or Excel to show the table. 

 You can very quickly build up your node system by running matrix searches. Each 
cell in a matrix is a node. Ensure that you do some node housekeeping after running these 
searches.  

This concludes the tutorial for Chapter 9 of Handling Qualitative Data. The final 
tutorial covers other aspects of reporting, ways of getting the results of your analysis 
“out” of NVivo and into the report. 

 

 



Tutorial for NVivo 2 Chapter 10 Telling it 
The final chapter of Handling Qualitative Data concerns the “telling” of your project, 
informally, then formally in a written report. It advises on doing a writing “stock-take” 
to learn from your logs and memos and assess any weaknesses or gaps revealed. 

It then advises on reporting results, appropriately using quoted material to illustrate and 
strengthen your argument, and making the all-important case that it is convincing. 

This tutorial offers two groups of software processes, the first on ways of reporting on 
your data and writing, and the second on extracting the appropriate material for use in 
your report. 

The bringing together of your results will involve every part of your NVivo project. To 
review what you need to know about the ways of seeing documents, nodes, models and 
results of your searches, revisit the pages on these topics in Introducing NVivo,. For 
Show tool, useful in making reports, go to pp. 16-17. 

You can make reports from NVivo on any aspect of your project. These will be saved as 
rich text files (.rtf), and can be opened in your word processor and incorporated in your 
writing report. 

1. Reporting on documents  
To report on the documents, or any set of them, go to the Document Explorer. 

1. Right mouse click on any set, or the set of All Documents, and view the options. 
You can list the documents (with descriptions, optionally) – a good way to start. 
Or you can get tables that profile information about them (for example dates of 
creation) or coding patterns. 

 
2. Select the report you want, view it on the screen and if you wish, when you close 

the window, save it as a file.  

3. Go to the folder in your project for Results and open the file in Word.  



 In Chapter 3, where Sets are described, one suggestion was to make a set of all 
the documents that will contribute to telling the project, with a pointer to each relevant 
document. If you don’t yet have a set called “Log trail documents”, you may find it useful 
to make one now. Put into it all the memos, diaries and reflective notes that will contribute 
to your log trail. Now you can report on just those documents, or search all those 
documents at any time, by setting the scope of the search tool to that set. 

4. Now report on a particular document. Click on that document, and right mouse 

to choose from the options:  

 If you like sitting under trees to think about your data, or wish to have the text 
of annotations for your project’s report, make a Text Report on the document and select 
to show the DataLink details as endnotes: this will give all the text of the document and 
also your annotations, all in .rtf format so you can copy into your Word report. 

2. Reporting on nodes 
Listing of nodes is covered in Chapter 6. But there are very many other ways of 
reporting on these critically important containers for your ideas. 

 In Chapter 6, where cataloging of nodes is discussed, there was advice to save 
periodically the catalog of your nodes that you create. If you followed that advice, go now 
to that archive and print out the reports, writing about the ways in which the node system 
changed over time. 

To report on nodes, the process is symmetrical with the document reporting process. 

1. Right mouse click on any set, or the set of All Nodes, and view the options. You 
can list the nodes (with descriptions, optionally) – a good way to start. Or you 
can get tables that profile information about them (for example dates of creation) 
or coding patterns.  



 
2. Now, just as for documents, you can report on any node – the information about 

it or the text coded at it. Right mouse click on any node and select from the 
options:. You wanted the text coded at the node? Select Make Coding Report.  

 

3. Ways of taking quotations into your writing 
The final chapter of Handling Qualitative Data advises on the use of quoted material, 
very strongly urging that your report should not be merely a patchwork of quotes. But of 
course you do need appropriate quotations.  

The most obvious ways of gaining access to the relevant quotations are to make the 
reports on documents or nodes as above. But rarely will you want to quote all of a 
document, or all the data coded at a node. Instead: 

1. As you write in your word processor, you can include quoted material from any 
document or node. Copy the required text from the Browser.  

 Even though the node browser does not allow editing, it will allow the “fast keys” 
such as Control-C for copy. 

2. Use the Search Tool to make a node that codes only the quotations you want – 
for example only those coded at one node and also another, or from cases with a 
particular characteristic. Report on the search node – and save paper and time!  



3. Ways of showing the whole project in your report 
Finally, as you move towards a final report, use the three ways of showing the project as 
a whole. 

1. If you have followed the advice to keep a Log Trail document, its text and the 
links from it will tell the grand story of the project. Make a text report with 
DataLinks as end notes, as above.  

2. If you have used models to show visually the stages in your analysis, go to each 
saved model and in the Model Explorer, export each to the Windows Clipboard 
and paste into your word processor report.  

 
3. At the Project Pad, from the Project menu, select List Project Information. 

The report that results tells the bare bones facts about your project!  

This concludes the tutorial for Chapter 10 of Handling Qualitative Data, and the series.  

Go back to the introduction to this series for advice on further sources of information 
about research processes using the software, and ways of working further with it. 

Happy researching – and don’t forget to back up your project!! 

 


